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Preface 

Introducing the Relativity Designer 
The Relativity Designer is an interactive, Windows-based development tool that 
enables the COBOL application developer to create a relational database view of 
data stored in existing COBOL files.  The Relativity Designer is used in all 
configurations of Relativity:  the single-tier Relativity Data Manager, which resides on 
a Windows-based system, and the two-tier Relativity Client/Server, which provides 
access to COBOL data that resides on a server system. 

The Relativity Designer provides the following functions: 

• Automatically extracts the definitions of data files from the COBOL source 
programs. 

• Collects information regarding the data from the application developer pertaining 
to the correct interpretation of the data file structure. 

• Allows the developer to define and maintain a relational database system of 
“tables” using the COBOL data.  All this information is stored in a catalog. 

This manual, the Relativity Designer Installation Guide, which is part of the Relativity 
document set listed in Related Relativity Documentation (on page 2), describes how 
to install the Relativity Designer software component and verify that the installation 
was successful.  The Relativity Designer installation instructions are the same, 
regardless of whether a non-client/server configuration (referenced throughout this 
documentation as “single-tier”) or client/server configuration of Relativity is being 
installed.  However, the Relativity Designer verification instructions do differ 
depending on whether a single-tier or client/server configuration of Relativity is being 
installed.  See Prerequisites (on page 15). 

In addition, your Relativity package contains the document, The Theory of Relativity, 
A Primer, which defines specific terminology and provides a comprehensive overview 
of the Relativity software tools and their functions.  Before you install this Relativity 
product, be sure to read this book. 
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Related Relativity Documentation 
In addition to the Relativity Designer Installation Guide and The Theory of Relativity, 
A Primer, the complete Relativity documentation set consists of the following items: 

• Relativity Client/Server Installation Guide.  A document (one for UNIX and 
one for Windows) that is intended for a System Administrator.  It describes the 
following: 

− How to install the Relativity Data Server software component on a computer 
running either a UNIX or Windows operating system and verify that the 
installation was successful. 

− How to: 

• Install the Relativity Data Client software component on a secure 
Windows workstation (such as the workstation belonging to a Database 
Administrator) for the purpose of catalog development. 

• Install the Relativity Server Administrator utility program in order define a 
server for the client and configure a server data source. 

• Verify communications between the client and the server. 

− How to install the Relativity Data Client software component on an end user’s 
Windows workstation and verify that the installation was successful by 
configuring a client data source and associating it with a server data source. 

− How to run the RM/COBOL Indexed File Recovery utility (recover1) to 
recover an RM/COBOL indexed file. 

• Relativity Data Client for UNIX Installation Guide.  A document that describes 
how to install and verify the Relativity Data Client software component on a 
UNIX-based server or workstation.  It also describes the utilities for creating client 
and server data sources. 

• Relativity Data Manager Installation Guide.  A document that describes how to 
install the Relativity Data Manager software component on a Windows-based 
workstation and verify that the installation was successful. 

• Relativity DBA Installation Guide.  A document that describes how to install the 
Relativity DBA (Database Administrator) software component on a Windows-
based workstation and verify that the installation was successful. 

• Relativity Java Client User’s Guide.  An HTML document, located in the JDBC 
directory of the Relativity Java Client Electronic Software Delivery download file 
and on the Relativity product CD, that describes the installation and verification of 
the Relativity Java Client as well as information about deploying it with Java 
applications and applets, and setting up data source connections.  The Java 
Client is a Java Database Connectivity (JDBC) component that resides in a Java 
runtime environment (JRE). 

• Relativity Online Help.  An online HTML help documentation system that 
provides fast access to detailed information on Relativity features and options.  
The help system also contains step-by-step presentations on how to accomplish 
specific tasks with Relativity and an extensive glossary.  A separate help file is 
provided for each of the various Relativity tools:  the DBMS (Data Client and 
Data Manager), the Designer, the DBA, the Relativity Configuration Utility, and 
the Server Administrator.  For more details, see Using Online Help (on page 3). 
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• Relativity README Files.  A set of online HTML documents that lists any 
changes to the Relativity documentation since its publication and contains new 
technical information that supplements the documentation. 

• RM-Install Program User’s Reference.  A document that describes how to 
configure and control the installations of RM/COBOL products, including 
Relativity. 

Using Online Help 
The Relativity Designer comes with extensive online assistance and step-by-step 
instructions.  You can access DSN Help while using Relativity in a number of ways.  
The method you use often depends on the type of information for which you are 
searching. 

• Help Contents.  In the Relativity Designer main window, from the Help menu, 
click Contents to open the Relativity Designer online HTML Help system.  The 
left side of the Help window (the navigational pane) contains the Contents, 
Index, Search, and Favorites tabs.  The right side of the Help window (the topic 
pane) displays the currently selected Help topic.  Across the top of the Help 
window is a group of buttons that help you navigate through the Help contents 
and perform other operations, such as printing a topic in the Help file. 

− To browse through topics grouped by subject:  Click the Contents tab.  
From here, you can go directly to more specific information and a list of all 
the Help topics by double-clicking any closed book icon.  Then select the 
topic of interest from the expanded list and click the topic.  The Help window 
for that topic appears in the topic pane. 

− To see a list of alphabetized index entries (or keywords):  Click the Index 
tab to find specific topics listed alphabetically (the online index is arranged 
just like a book index).  Type an entry or the first few letters of the word you 
want to search for, or scroll through the list.  Then select the topic and click 
the Display command button.  The content of the Help topic opens in the 
Help window. 

− To search for words or phrases that may be contained in a Help topic:  
Click the Search tab.  Follow the instructions on your screen to complete this 
task. 

− To create a list of preferred Help topics:  Click the Favorites tab.  Follow 
the instructions on your screen to complete this task.  Note that, by default, 
the contents of this tab is empty until you select topics to populate it.  The 
content of the Favorites tab is automatically saved between sessions. 

• Context-sensitive Help.  While you are working in Relativity, you also can press 
F1 to access the associated Help topic for currently selected menu commands, 
toolbar buttons, dialog box options, and other screen elements. 

• Tool tips.  When you pause with the pointer (without the mouse button pressed) 
over an item on a toolbar, a small pop-up window that includes a brief description 
is displayed. 

• Help button in a dialog box.  If available, click the Help button in the dialog box 
you are using.  A Help topic explaining the dialog box appears. 

You can exit Relativity online Help from the Help window by clicking the Close button 
on the title bar or double-clicking the Control Menu icon at the left end of the title 
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bar.  To exit a context-sensitive Help window, if necessary, press the Esc key on the 
keyboard. 

From the Relativity Designer Help menu, you can also access additional online Help 
files: 

• Click DBMS Help File for information on using the Relativity Data Manager. 

• Click Server Admin Help File for information on using the Relativity Server 
Administrator. 

• Click Relativity Configuration Help for information on using the Relativity 
Configuration Utility to set options that apply to all Relativity data sources. 
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Conventions Used in this Document 
This document contains visual cues to help the reader identify important information. 

Table Convention Indicates 

Initial Capitals Menu names, command names, and dialog box, window, and 
form titles. 

Bold Menu, command, and button names. 
Other elements to be selected or typed to accomplish an 
action. 
Label on input media used during installation. 

Italic Reference to a topic in the current document or another 
Relativity document. 
Reference to another document. 
Emphasis. 

Bold Italic Variables. 

Technical Support 
Micro Focus is dedicated to helping you achieve the highest possible performance 
from the RM/COBOL family of products.  The technical support staff is committed to 
providing prompt and professional service to you when you have problems or 
questions about your Micro Focus products. 

Technical support services are subject to Micro Focus’s prices, terms, and conditions 
in place at the time the service is requested. 

While it is not possible to maintain and support specific releases of all software 
indefinitely, we offer priority support for the most current release of each product.  For 
customers who elect not to upgrade to the most current release of the products, there 
is free support available on the Micro Focus Community Forum: 
community.microfocus.com 

Support Guidelines 
When you need assistance, you can expedite your call by having the following 
information available for the technical support representative: 

• Company name and contact information. 

• Micro Focus product serial number (found in the Electronic Product Delivery 
email, or in the License Certificate). 

• Micro Focus Relativity product version number. 

• Operating system and version number. 

• Hardware, related equipment, and terminal type. 

• Exact message appearing on screen. 

http://community.microfocus.com/
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• Concise explanation of the problem and process involved when the problem 
occurred. 

Test Cases 
You may be asked for an example (test case) of the source that demonstrates the 
problem. 

• The smaller the test case is, the faster we will be able to isolate the cause of the 
problem. 

• Do not send full applications. 

• Reduce the test case to the smallest possible combination of components 
required to reproduce the problem. 

• If you have very large data files, write a small program to read in your current 
data files and to create new data files with as few records as necessary to 
reproduce the problem. 

• Test the test case before sending it to us to ensure that you have included all the 
necessary components to run the test case. 

When submitting your test case, please include the following items: 

1. README text file that explains the problems.  This file must include 
information regarding the hardware, operating system, and versions of all 
relevant software (including the operating system and all RM/COBOL products).  
It must also include step-by-step instructions to reproduce the behavior. 

2. Program source files.  We require source for any program that is called during 
the course of the test case.  Be sure to include any copy files necessary for 
recompilation. 

3. Data files required by the programs.  These files should be as small as 
possible to reproduce the problem described in the test case. 

Contact information 
Our Web site gives up-to-date details of contact numbers and addresses.  

Additional technical information or advice is available from several sources.  

The product support pages contain considerable additional information, including the 
WebSync service, where you can download fixes and documentation updates. To 
connect, enter http://www.microfocus.com in your browser to go to the Micro Focus 
home page.  

If you are a Micro Focus SupportLine customer, please see your SupportLine 
Handbook for contact information. You can download it from our Web site or order it 
in printed form from your sales representative. Support from Micro Focus may be 
available only to customers who have maintenance agreements. 

You may want to check these URLs in particular: 

• https://www.microfocus.com/products/relativity/ (trial software download and 
Micro Focus Community files) 

http://www.microfocus.com/
https://www.microfocus.com/products/relativity/
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• https://www.microfocus.com/support-and-services/documentation/ (documentation 
updates and PDFs) 

 

https://www.microfocus.com/support-and-services/documentation/
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Chapter 1:  Installation 

This chapter lists the system requirements and describes how to install the Relativity 
Designer software program on a Microsoft Windows operating system.  The 
installation procedure is the same regardless of whether a client/server or single-tier 
configuration of Relativity is being installed.  Procedures for removing the Relativity 
Designer (see page 10), if necessary, are also provided. 

System Requirements 
Installation of the Relativity Designer on a Windows-based workstation for application 
development requires the following minimum software and hardware. 

Component Requirement 

Computer An IBM PC or compatible machine with a Pentium-class processor 
or higher. 

Operating 
System 

Windows XP, Windows 7, or higher. 

Memory 64 MB is recommended. 

Disk Space A hard drive with at least 11 MB of free disk space. 

Installation Media Internet access and/or one CD-ROM drive. 

Monitor 800 x 600 resolution is required.  Higher resolution is 
recommended. 

Internet Browser A browser (for example, Mozilla Firefox or Microsoft Internet 
Explorer) capable of viewing HTML files, such as the README text 
or other documents that are available in this format. 

Adobe Reader This software, available free from Adobe.com, allows you to view 
(and print) the Portable Document Format (PDF) documents. 
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Installing the Relativity Designer 
Note  If you have a previous version of Relativity installed, you should remove it prior 
to installing a newer version.  See Removing the Relativity Designer (on page 21). 

The Relativity Designer can be installed on a Windows workstation using the 
following methods: 

• Electronic Product Delivery Installation (as described below) 

• CD-ROM Installation (see page 11) 

You may also automate the installation program for the Relativity Designer, which 
allows the installation of the Designer to be incorporated with the installation of your 
application.  For more information, navigate to 
http://supportline.microfocus.com/productdoc.aspx and refer to the “Relativity 
Designer Installation Details” section of the RM-Install Program User's Reference 
documentation. 

To verify that the installation is successful, see Chapter 2:  Verification (on page 22). 

Note  The instructions that follow refer to an installation components directory, which 
is the directory to which the deliverable file via electronic software delivery was 
downloaded and decompressed. 

Electronic Product Delivery Installation 
Note  You must have an Internet connection and an Internet browser installed to 
proceed with this method of installation. 

All Relativity orders generate an Electronic Product Delivery (EPD) email that 
contains links to download the product. It also contains a link to download the 
product’s License Certificate (also called the license file) for the order, which will be 
necessary to install the product. Finally, there are instructions about how to 
decompress the download file and begin the installation. This section will elaborate 
on the process of downloading the order and preparing to install the product. 

All Relativity EDP orders contain links to download the product as a CD-ROM image, 
in the form of a compressed .iso file, and to download a smaller installation, in the 
form of a self-extracting compressed file. And you can also elect to have a physical 
CD-ROM shipped to you. (You can also use a CD-ROM burner drive to create your 
own physical CD-ROM using the .iso file, if you do not wish to wait for it to be 
shipped.) The CD-ROM (both .iso and physical) contains installation files for all the 
supported platforms. The smaller self-extracting compressed file version contains the 
installation for only the platform purchased by the order. 

(Although using the CD-ROM image is not common, this section will cover it, for sake 
of completeness.) 

The process begins with the arrival of a Micro Focus Electronic Product Delivery 
email which was generated when your order was complete. There is a link in this 
email on which to click to browse to the Electronic Product Delivery website. Once 
you have clicked on that link, a login page will appear in your browser. Use this page 
to login with your Micro Focus account. There will be an individual Invoice line for 
each item in your order. Locate the invoice line for the Relativity Designer, and click 
on the + in the left hand column. The invoice line will expand, displaying three tabs: 
Software/Licenses, Documentation, and Legal Information, with Legal 

https://supportline.microfocus.com/productdoc.aspx
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Information selected. After you review the End User License Agreement in the Legal 
Information tab, click on the checkbox in Step 2 at the beginning of the email. (This is 
necessary to acknowledge the acceptance of the End User License Agreement. You 
will not be able to proceed until the checkbox has been checked.) Next, select the 
Software/License tab and click on the + to the left of the serial number. You will then 
be presented with the lines for downloading the complete CD-ROM image (ISO), for 
downloading a smaller self-extracting installation file, and for downloading the license 
key. 

At a minimum, click on the “here” in “Please click here to download your license key” 
to obtain the License Certificate file. This will download the certificate file on your 
browser’s download directory with the name liant-xx-nnnn-nnnnn-IDnnnnnn.lic. 
Copy this file to a safe place in case you need to install the product again, and place 
it in an easily accessible location on the target machine. 

The next two sections deal with downloading, decompressing, and installing the 
desired installation media. 

Installing CD-ROM Media 

If you elected to receive physical media, insert the media into the machine’s CD-
ROM drive and close the drive. Windows will automatically detect the media’s 
presence and mount it. If the machine is configured for AutoPlay, the RM-Install 
program will begin running and start the installation. If the machine is not configured 
for AutoPlay, open a Windows Explorer window. In the left hand pane, under 
Computer, locate the entry for the CD-ROM drive (it should have the volume name 
RMRelativity12xx), and right-click on it. In the pop-up menu, select RM Install. 
Proceed to the Installing the Relativity Designer section below. 

If you elected to download the compressed ISO file, it will be compressed using gzip 
and will need to be decompressed before installation, although the Chrome browser 
may decompress it automatically. (Click on the Documentation tab in your EDP 
order to obtain up to date details on this process. Use the “Installation Guide to 
Installing an ISO Image” instructions.) The downloaded file will have a name similar 
to rmrelativity12xx.igz. 

Note: The following instructions assume that the gzip utility has been installed on the 
machine and is in your PATH. (If the following instructions are unclear to you, please 
use the Installing from Self-Extracting Executable option below.) 
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From the Start menu, open a Command Prompt window, change directory to the 
directory where the .igz was downloaded, and rename the file’s extension from .igz to 
iso.gz. 

ren rmrelativity12xx.igz rmrelativity12xx.iso.gz 

Then decompress the file with the command: 

gunzip rmrelativity12.iso.gz 

If this command results in an error, then the .igz file has already been decompressed 
by the browser, in which case, all that needs to be done is rename the file without the 
.gz extension. 

ren rmrelativity12.iso.gz rmrelativity12.iso 

An .iso file is useful for burning a CD with Relativity installation. Use the .iso image 
burning feature included with Windows 10 or later, or third-party CD-ROM Burning 
software, such as Nero (http://www.nero.com) or Roxio’s Easy CD Creator 
(http://www.roxio.com), to create physical media. 

On Windows 10 and later, to create physical media, open a file explorer window on 
the folder that contains the .iso image file, then right-click on the file and select Burn 
Disk Image from the menu and follow the directions. (Note that Burn Disk Image is 
not the same as burning a CD with the .iso file on it.) 

After you create a CD, follow the instructions at the beginning of this section for how 
to start the installation. 

Alternatively, on Windows 10, .iso files can also be mounted as a virtual CD. Simply 
open Windows Explorer, navigate to the directory containing the ISO file. Right click 
on the .iso file and select Mount from the pop-up menu. This may be done with 
Windows 7, but additional software will need to be installed first, such as Virtual 
CloneDrive. 

After the .iso file has been mounted, follow the instructions at the beginning of this 
section for how to start the installation. 

Installing from Self-Extracting Executable 

The most common case is to use the .exe file download. When downloaded, the file 
will have a name similar to rmrelativity12xx_dsn_win_32.exe. (Where 12xx is the 
version of Relativity.) If it is not there already, copy the .exe file to the target Windows 
machine. Then double click on the .exe to start the installation. The file will be 
decompressed into a temporary directory on the target machine, and the RM-Install 
program automatically started. Proceed to the Installing the Relativity Designer 
section below. 

http://www.nero.com/
http://www.roxio.com/
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Installing the Relativity Designer 

At this point in the installation: 

• The License Certificate file has been downloaded from the EDP order and is 
available on the target machine. 

• You have the CD-ROM (or .iso file) mounted and RM-Install is running, or 
you have executed the Self-Extracting Executable, it has extracted itself into 
a temporary directory, and RM-Install is running. 

Next, follow the instructions below to install the Relativity Designer software. 

1. Follow the instructions presented on the pages of RM-Install and press the Next 
or Back button to advance through the various pages. 

2. On the Software License Agreement page, you must click “I accept the terms in 
the license agreement” in order to continue with the installation. 

3. On the License Certificates page, the license certificate file for the product 
being installed is displayed.  Do one of the following: 

• If the license certificate for the Relativity Designer software being installed is 
present in the list area, press the Next button. 

• If the license certificate for the Relativity Designer software being installed is 
not present in the list area: 

a. Press the Add button. 

b. In the Select License Certificates dialog box, navigate to the directory 
containing the License Certificate file for the Relativity Designer software 
being installed and select the filename for the license certificate.  (This 
license file is downloaded from the EDP page for the order.) 

c. Press the Open button and then press Next. 
4. On the Installation Type page, do one of the following: 

• Select the Standard Installation option to install all the components of all 
the license certificates listed on the License Certificates page immediately, 
using their default settings.  Press the Install button. 

• Select the Custom Installation option to select specific components (for 
those products with multiple components) of all the license certificates listed 
on the License Certificates page, and install them, changing their default 
installation settings, as necessary. 

Follow the custom installation instructions presented on the remaining pages.  
On the Ready to Begin Installations page, press the Install button. 

When the installation for the Relativity Designer program starts, follow the 
additional instructions presented by the installation program. 

5. When either the standard or custom installation is complete, click the Finished 
button on the Installation Status page. 

Removing the Relativity Designer 
The Relativity Designer can be removed from the Windows workstation on which it 
was installed.  This may be necessary if the Relativity Designer is to be moved to a 
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different machine or if a new release of the Relativity Designer is to be installed on 
the same machine. 

To remove the Relativity Designer: 

1. Open the Windows Control Panel. 

2. In the Control Panel, do one of the following: 

• On Windows XP, double-click Add or Remove Programs. 

• On Windows 7 or Server 2008, double-click Programs and Features. 

3. In either the Add or Remove Programs window or the Programs and Features 
window, select RM Relativity v12.xx Designer from the list of currently installed 
programs and updates, where xx is the version number of the product to be 
removed. 

4. Do one of the following to start the uninstall process: 

• On XP, click the Remove button. 

• On Windows 7 or Server 2008, click the Uninstall button. 

5. In the message box, click Yes to proceed with the uninstall process. 

6. The RM Relativity v12xx Designer dialog box is then displayed, detailing the 
progress of the uninstall. 

When the uninstall is successfully completed, click OK. 

7. Click OK to close either the Add or Remove Programs window or the Programs 
and Features window. 

8. Close the Windows Control Panel. 
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Chapter 2:  Verification 

This chapter describes how to verify the installation of the Relativity Designer 
software on a Windows-based workstation.  The verification takes place with a 
catalog that was installed during the installation of the Relativity Data Manager or 
Relativity Data Server, and a data source named Verify that was created during the 
verification of the installation of the Relativity Data Manager or Relativity Data Server 
and Data Client products. 

In addition, the Relativity Designer software includes three sample databases called 
Shirt-1, Shirt-2, and Shirt-3.  These three databases contain COBOL data files, 
COBOL source programs, and COBOL schema (or RST) files.  The Shirt-3 sample 
also contains a Relativity database catalog for the COBOL data files.  The Shirt-3 
database has its ownership assigned to the DB3 Owner group with a password of 
1234.  The sample files are provided for both RM/COBOL and Micro Focus COBOL, 
and are used in conjunction with Relativity training.  However, they may also be used 
as a convenient database to experiment with the Relativity Designer. 

Prerequisites 
This verification process assumes the following: 

• If you are using the client/server version of Relativity, that you have followed the 
instructions in the Relativity Client/Server Installation Guide (for either UNIX or 
Windows, as appropriate) to install a Relativity Data Server, set up a server data 
source named Verify, install a Relativity Data Client on the same machine as the 
Relativity Designer, and set up a client data source that is also named Verify and 
associate it with the server data source, Verify. 

• If you are using the single-tier (that is, non-client/server) version of Relativity, that 
you have installed a Relativity Data Manager on the same machine as the 
Relativity Designer and followed the instructions in the Relativity Data Manager 
Installation Guide for setting up a data source named Verify. 
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Starting the Relativity Designer 
To start the Relativity Designer in Windows 7: 

1. Click Start, click All Programs, click RMCOBOL, click Relativity vxx (where vxx 
is the version number of the product), and then click Designer. 
The Welcome to Relativity window is displayed and you are ready to open the 
Verify data source. 

 

Note  The Welcome to Relativity window appears when you first install and start 
the Relativity Designer.  From this window, you can set up and create a new data 
source, or open an existing or recently used Relativity data source.  After 
completing the first session with Relativity, the most recently used data source is 
always selected by default in this window when you start Relativity again.  To 
disable the Welcome to Relativity window after the initial installation, clear the 
Show Welcome at Startup check box.  Subsequently, when you start another 
Relativity session, you will begin all operations in the Relativity Designer main 
window.  You may, however, enable this capability again by choosing Welcome 
from the Tools menu. 

2. If you wish, click Cancel to dismiss the Welcome to Relativity window. 
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Opening a Data Source 
To open the Verify data source: 

1. In the Relativity Designer main window, on the File menu, click Open Data 
Source. 

The Open Relativity Data Source dialog box opens. 

 

Alternatively, if the Welcome to Relativity window remains displayed, click either 
the Recent or Existing option, select the Verify data source from the list, and 
then click OK.  Proceed to Step 3. 

2. In the Data Source Name box, select Verify.  If necessary, click the Down Arrow 
to display a list of data source names. 

3. Click Open. 

The Logon dialog box opens to collect information needed in order to 
authenticate your access to the server. 

 

4. In the Logon dialog box, type a user name in the appropriate box and click OK.  
(Because security has not been set up to access the Verify data source, any user 
name will suffice and no password is required.) 
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The Catalog window for the selected data source, Verify, is displayed in the 
Relativity Designer main window. 
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Displaying the Table Form 
1. On the Catalog window, click Tables in the Catalog Objects area. 
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2. Double-click the table name BackOrder. 
The Table form for the BackOrder table opens. 
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Viewing COBOL Data 
1. Click the Show Table Contents button on the Table form toolbar.  The contents 

of the data items in the Table form are displayed in the Show Table Contents 
form. 

 

2. Click the Close button to exit the Show Table Contents form. 

Closing the Data Source 
To close a data source, do one of the following: 

• On the File menu, click Close Data Source.  Shortcut:  Ctrl+D. 

• In the Catalog window, click Close in the upper-right corner of the title bar. 

When you close a data source, the Relativity Designer main window remains open, 
allowing you to reopen the data source, open another data source, or exit the 
Relativity Designer. 
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Exiting the Relativity Designer 
To exit the Relativity Designer, do one of the following: 

• On the File menu, click Exit.  Shortcut:  Ctrl+F4. 

• In the Relativity Designer main window, click Close in the upper-right corner of 
the title bar. 
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